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27 introduction As you complete each priceless quilt, a story is waiting to be told. You've invested so much of yourself, your time, and your creativity. How
can you ensure that your quilt's history is told and remembered as it's passed from hand to hand? And if you're giving your quilt as a gift, how can you make
the presentation even more impressive and meaningful? The HP Custom Quilt Label Kit is the perfect solution, allowing you to create one-of-a-kind,
professional-quality labels for your quilt to ensure that its story is told and its quilter is remembered. And, as a perfect companion to each quilt, you can make
a coordinated, high-quality gift card conveniently and economically. The HP Custom Quilt Label Kit contains: · A variety of layouts for Story Labels and
Made-By Labels Story Labels are 8 1/2" x 11" labels for sharing a story, poem, verse from a song, or the fascinating details of your quilt. For example, is it
for a particular occasion? Does the fabric you've selected have special meaning? How did you piece it together? Made-By Labels are smaller-sized labels
(four labels on an 8 1/2" x 11" sheet) that contain essential information like your name, the date the quilt was completed, and the occasion. They can also
include your photograph. · Easy-to-use layouts for gift cards that match the labels and add a truly unique touch to a quilt that you're presenting as a gift. ·
Hundreds of high-quality images and clip art for use in your labels and gift cards. Images, phrases, clip art, borders, and backgrounds are grouped into
various "themes" to help narrow your search for appropriate artwork and phrases.
@@@@Here's what you'll do: 1. Install and start the program. 2. Get an overview of the program's features. 3.
@@· Then you'll make a matching gift card. 4. @@Note: Screen captures of the HP Custom Quilt Label Kit shown in this booklet are from the Microsoft®
Windows® XP operating system. While the screens you see may look different on your computer, the functionality of the program works just the same. Please
follow our instructions exactly, even if the screens you see look slightly different.
Note: If Setup does not start automatically, open Windows Explorer, locate and double-click the letter for your CD-ROM drive, then double-click Setup.exe. 2.
Click Install and follow the onscreen instructions to install the program. 3. If prompted, restart your computer. When installation is complete, you see a
window similar to this one. 4. Make sure Launch hp custom quilt label kit is selected. 5.
Keep the View ReadMe.txt option selected if you'd like to read last-minute notes about the program. 6. Click Finish. installing and starting the program You
have two options for installing the program: · Install it on your computer. · Don't install it on your computer, but run it from the CD-ROM. (This is
particularly useful if you have limited space on your hard drive.) Below are instructions for installing and starting the program using each option. Macintosh
1. Insert the CD into your CD-ROM drive.
Note: If the installer does not start automatically, double-click the hp custom quilt label kit CD icon on your desktop. Then double-click the installer icon. 2.
Click Install. Follow the on-screen instructions to install the program.
3. If prompted, restart your computer. installing the program on your computer Windows 1. Insert the CD into your CD-ROM drive. Setup starts
automatically.
4 5 running the program from the CD-ROM Windows 1. Insert the CD into your CD-ROM drive. Setup starts automatically. Note: If Setup does not start
automatically, open Windows Explorer, locate and double-click the letter for your CD-ROM drive, then double-click Setup.exe. 2. Click Run from CD-ROM.
We've shown some of the ready-made designs below, along with descriptive names of the templates we used, so you can find the template that best suits your
interests. Macintosh 1. Insert the CD into your CD-ROM drive.
Note: If the installer does not start automatically, double-click the hp custom quilt label kit CD icon on your desktop. Then double-click the installer icon. 2.
Click Run from CD-ROM. Story Label portrait Story Label landscape Story & Made-By Label To start the HP Custom Quilt Label Kit in the future: Windows
1. Click the Start button. 2. Select All Programs. 3. Select hp custom quilt label kit.
4. Select hp custom quilt label kit again. Made-By Labels 4 per sheet Gift Card Top Fold outside Gift Card Top Fold inside Macintosh 1. Locate the folder
where you installed the software. 2.
Double-click the hp custom quilt label kit icon. Gift Card Side Fold outside Gift Card Side Fold inside We've also included blank templates: overview of the
program choosing a template When you start the program, you can select from a variety of blank templates or ready-made designs for your labels and gift

cards. Ready-made designs are an excellent, inspiring starting point. 6 Blank portrait Blank landscape 7 overview of main window The main window displays
the most common features in convenient locations so you can quickly start creating designs.
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5.
Work Area: This is where you will add images and text to create your labels, gift cards, and custom designs. This area is a scaled representation of your
printable page. Objects will print larger than they're shown. 6. Placeholders: Drag and drop images, phrases, clip art, borders, and backgrounds into these
boxes. 1 getting help online help 2 3 5 6 The online help contains step-by-step instructions for creating MadeBy Labels, Story Labels, and gift cards. It also
explains how to make your own fabric sheets, how to print your designs, and more. You can access the online help in two ways: · From the Help menu, choose
Help. · Click the Help button. 4 1.
Tabs: Contain images, phrases, clip art, borders, and backgrounds for use in your label or gift card designs. 2. Border and Background Controls: Allow you
to change the look of borders (e.g., thick oval or thin rectangle) or backgrounds (e.g., color). Borders and backgrounds are the same design, but borders are
cut out in the center to create a frame effect. 3. Text Controls: Allow you to add new text and change the look of your text (e.
g., font, color, and alignment). 4. Icon Bar: Lets you quickly get help, create a new design, save your design, or print your design. 1.
Contents: Displays in the gray box at the top of each help page. Click a title to view its help page. The title of the current help page appears in bold within the
list of available topics. 2. Index: Displays when you click Index in the Table of Contents.
Click the item you're looking for from the alphabetical list of topics. 3. Related topics: Displays at the bottom of many help pages. Click a topic in the list to
view information that is related to the current help page. 2 1 3 8 9 contacting hp customer care The HP Customer Care Center provides expert advice on
using and solving problems with your HP Custom Quilt Label Kit software. HP's Customer Care support process works most effectively if you look for
assistance in the following order: 1. Use the online help. 2. @@3. @@@@However, standard phone company charges apply.
@@@@@@· Messages displayed around the time the situation occurred. · Has this happened before? Can it be re-created? @@@@Contact HP Customer
Care by phone during regular business hours. @@@@· For support on any HP product, visit the HP Web site for the latest support information at
www.hp.com/support. quilting web site Visit the online HP quilting community and get free project ideas with instructions, templates, patterns, expert tips,
sen? · Is it for a particular occasion? · Does the fabric you've used have special meaning? · What pattern have you used? · Why have you chosen this color
scheme? @@Create separate text boxes to vary the text styles. 5. Click and drag the text box until you see the resizing handles. @@6. Click the Add Text
button.
7. Type "To the dad of our dreams!" 8. @@Click the Save button. 2. @@For a file name, use "astronomy story label.
" 4. @@@@Making your own fabric sheets requires some planning and time. But it can be easy, fun, and economical. @@@@Step 4: Cut out the fabric
label and sew it onto your quilt. 9.
Click anywhere outside the text box. @@Release the mouse button. @@@@@@Then print on fabric sheets when you're ready. 2. Follow these steps: 2. In
the next screen, select Gift Card Side Fold outside and click OK. You see the selected template in the design area. Notice the labels for the Back and Front of
the card. Windows a. Click the Print button.
b. Click the Change Settings button. c. Click the Properties button. d. Select the options for Best print quality and Plain Paper. Click OK to begin printing. 3.
Now you can cut out your label and sew it onto your quilt. adding backgrounds 1.
Click the Backgrounds tab. 2. From the Backgrounds Theme list, select Celestial. 3. Click and drag the dark blue stars background to the left (back) side of
the card until you see a green highlight.
Then release the mouse button. 4. Click the blue stars background and it will fill the entire area around the card. Macintosh a. In the File menu, select Page
Setup.
b. If given the options, select Best print quality and Plain Paper. Mac OS X users, be sure to select your printer from the Format For list. Click OK. c. Click
the Print button. d. Click the Print Now button. 1 creating a matching gift card You'll be creating a two-sided gift card: one side will be the outside and the
other the inside. These are two separate designs using the HP Custom Quilt Label Kit.
2 4 3 step 1: create the front and back of your gift card selecting a template 1. To start the HP Custom Quilt Label Kit, follow the instructions on page 6. If the
program is already open, click the New button. 18 19 adding images 1. Click the Images tab. 2. From the Images Theme list, select Celestial. 3. Click and
drag the image shown to the right (front) side of the card until you see a green highlight. Then release the mouse button.
4. Use the resizing handles on the outer corners of the image to resize it, as shown. adding text Now, let's add text to the front of your card. 1. Click the Add
Text button.
2. Type, "Happy Birthday, Dad!" 3. In the Text Controls area, make these settings: · Font: Arial · Text Color: Red · Size: 36 · Align: Center · Click the (bold)
button A text box appears. 1 3 4. Click anywhere outside the text box.
Then, click and drag the text box under the image until you see a green highlight. Release the mouse button. 5. Click the text box and use the left and right
resizing handles to make the text fit inside the border, as shown. 2 4 3 5 4 20 21 saving the front and back of your gift card 1. Click the Save button. 2. Go to
the folder you created earlier called "My Labels and Cards." 3. For a file name, use "astronomy card outside.
" 4. Click Save. adding clip art 1. Click the Clip Art tab. 2. From the Clip Art Theme list, select Celestial. 3. Click and drag the star to the right side of the
card until you see a green highlight. Then release the mouse button. Position it as shown.
tip: In the future, you can open a saved design in the HP Custom Quilt Label Kit by selecting Open in the File menu, locating your saved design, selecting it,
and clicking Open. 1 2 step 2: create the inside of your gift card selecting a template 1. To start the HP Custom Quilt Label Kit, follow the instructions on
page 6. If the program is already open, click the New button. 2.
In the next screen, select Gift Card Side Fold inside and click OK. You see the selected template in the work area on the right. 3 adding backgrounds Follow
the steps on page 19 to add backgrounds to the inside of your card to look like this: 22 23 adding text Now, let's add text to the inside of your card using a
phrase. 1. Click the Phrases tab.
2. From the Phrases Theme list, select Celestial.
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3. Click and drag the "Keep Shining" phrase into the right side of the card until you see a green highlight. Then release the mouse button. 4. In the Text
Controls area, make these changes: · Font: Arial · Text Color: Red · Size: 36 · Align: Center · Click the (bold) and saving the inside of your gift card 1. Click
the Save button. 2. Go to the folder you created earlier called "My Labels and Cards.
" 3. For a file name, use "astronomy card inside." 4. Click Save. printing your gift card How you print your gift card depends on what type of gift card you
have created. · For our example, we created a two-sided gift card. For twosided cards, you print the front and back of the card on one side of the paper. Then
you put that paper back into the printer to print the message on the inside of the card. · One-sided gift cards are printed on the front and back only, with one
pass through the printer. The inside is left blank, allowing you to write your personal message.
(italics) buttons. 5. Click the text box and use the left and right resizing handles to make the text fit inside the border, as shown. 1 tip: To learn how to feed
paper in your printer so it prints on the correct side and with the correct orientation, use a blank sheet of plain paper and write, "Top" and "Front" on it as
shown here: Top Front 2 Now place this sheet into the printer paper tray and print the outside of the card. Note the locations of your writing relative to the
printed output.
Then, insert the sheet into the paper tray again and print on the inside of the card. 4 3 5 step 1: printing the front and back of your gift card Note: Follow
these instructions even if your printer has a duplex (2-sided) printing option. Before printing, review the detailed tips and instructions in the online topic
called "printing your designs." Exactly how you make selections for printing depends on your printer and the type of media you are printing on. Refer to your
printer's help for more information.
25 24 1. @@@@2. Open the design for the outside of your gift card. (The file name for our project is astronomy card outside.soq.) 3. Follow these steps:
Windows a. Click the Print button. b. Click the Change Settings button.
c. Click the Properties button. d. @@Click OK. Click OK again to begin printing. Macintosh a. In the File menu, select Page Setup. b. @@Mac OS X users,
be sure to select your printer from the Format For list. Click OK.
c. Click the Print button. d. Click the Print Now button. Note: If the colors aren't quite right, try experimenting with other print settings until you find the ones
that work best with your printer.
4. When you take the paper out of the printer, allow the ink to dry completely before touching it or printing the inside of your card. advanced creativity Now
that you've learned all the basics, imagine what more you can do with the HP Custom Quilt Label Kit, your printer, and fabric sheets! Here are some other
ideas for inspiration: Recall images of family vacations and tell their stories on the back side of washable placemats for your dining table. Make milestone
events even more special with matching keepsake quilts, Story Labels, and gift cards. step 2: printing the inside of the gift card 1.
Open the design for the inside of the gift card. (The file name for our project is astronomy card inside.soq.) 2. Place the printed card in the paper tray. The
proper placement in the paper tray depends on your printer. For printers where you load paper in the front, insert the paper with the already printed side up.
3. Repeat the steps above to print the inside of the gift card. 4.
Now you can use a pen to sign your gift card. 26 27 advanced creativity Print your favorite photos of your furry friends on fabric sheets to create theme
projects, like scrapbooks, totebags, and clothing. advanced creativity Bring your flower garden indoors by taking digital photos or scanning dried flowers and
using them in your quilting projects, like these decorative throw pillows and sachets. Print custom pictures and text onto fabric sheets and sew the label onto
doggy raincoats or bandannas. Design your own fabric sheets to create these soft, sculptured chickens-- use beads and yarn to create a whimsical string of
chickens or use them individually as pin cushions. 29 28 advanced creativity advanced creativity Replace ordinary framed photos with window pane quilts-- a
unique way to capture priceless childhood moments. Celebrate and share your family's ancestry through one-of-a-kind genealogy quilts using scanned
photographs. 30 31 advanced creativity Colorize a digital photo using an image editing tool to create vibrant, artistic quilts. tip: Take a moment to visit the
online HP quilting community for more unique project ideas! www.hp.
com/go/quilting 32 .
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